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1.0  METHOD OF INTEGRATION 
With Analog Inband integration, one pathway between the Merlin Magix 
and the INTUITY AUDIX LXTM system transmits both call information 
and voice communications.  The pathway is provided using a 2-wire 
analog single-line circuits that connect to voice cards in the system.  The 
voice card simulates 2-wire analog lines.  Calls to an INTUITY AUDIX 
LXTM port are preceded by the called-party information from the Merlin 
Magix in DTMF format.  The INTUITY AUDIX LXTM system answers 
and plays the appropriate greeting.  Message-waiting indication is set and 
canceled by using DTMF commands over the same pathway. 

2.0  AVAYA INTUITY AUDIX LXTM ORDERING INFORMATION 
• Voice Port Cards, four analog connections per card, (three cards per 

system) 

• Software Release R1.x, R2.0 

• Serial and In-band Integration software 
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3.0  PBX HARDWARE REQUIREMENTS 
• 016TRR (16-tip/ring extensions with 4 touch-tone receivers) one 

analog port, per INTUITY AUDIX LX port (see Considerations 
section 8.5 and 8.6) 

Minimum Requirement for analog 016TRR cards is release 19. Please 
refer to Consideration 8.6 

• RJ11 Telephone cords, one per voice mail 

• 129B frequency generator 30 Hz., or 129C frequency generator 25 
Hz. 

NOTE: Depending upon the size of the INTUITY AUDIX LX, 
additional Touch Tone (DTMF) Receivers might be necessary. 
Use Table 1 as a guideline for determining your requirements.  

 

Number  
of IA LX 

ports 

1 

2 

3 

4 

6 

8 

12 

Number 
    of  016 

modules 

1 

1 

1 

1 

2 or 1 

2 or 1 

3 or 2 

Number of 400 or 
400 GS/LS/TTR 

modules 

0 

0 

0 

0 

0 or 1 

0 or 1 

0 or 1 

Number of  
TTRs needed 

1 

1 

2 

2 

3 

4 

6 

Table 1 - DTMF Receiver Requirements 

 

3.1  PBX SOFTWARE REQUIREMENTS 
• Minimum Software: Release 1 or 2 

• Hybrid/PBX configuration (see section 8.2) 

4.0  SUPPORTED FEATURES 
• Call coverage to personal greeting 

- busy 
- ring-no-answer 
- all calls (see section 8.3) 

• Message-Waiting Indicator 
- LED 

• Automated Attendant  

PBX hardware requirements 

Supported integration features 
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• Outcalling 

• Multiple return-to-operator  

• Direct Call 

• Personal greeting of original-called party on a double-call forward 
using call coverage 

• Reply to message left by subscriber in internal telephone-answering 
mode (See Section 8.5). 

5.0  CONFIGURING THE MERLIN MAGIX TO INTEGRATE 
The Voicemail system connects to the PBX as if it were a series of single line 
telephones. These single line telephones are referred to as analog ports that 
will be connected to the INTUITY voice portion of the voicemail system. 
Each port requires an RJ11 connection into the INTUITY. 
 
It is important that these analog ports have the ability to: 
Send and recognize DTMF tones, 
Forward on Busy and Ring-no-answer, 
Perform transfers using switch-hook flash, 
 
These analog ports must be configured in a hunt group. The hunt group is 
created in the PBX to allow the station to hunt to the next voice port. Call 
Information is passed from the PBX to the INTUITY using DTMF tones also 
called touch-tones. The call information should contain, at the minimum, the 
called party ID. For a better integration, the switch should pass Calling Party 
ID and the reason code why the call was forwarded. 
 
When a message is left for a users telephone, a second pattern of DTMF 
tones are passed to the PBX from the voice mail system using pre-determined 
codes to activate and de-activate message waiting.  
 
In addition, all users telephones must be programmed to forward to the Pilot 
Number of the voicemail system on a ring-no-answer and busy condition. 
 
In case MWI support is needed, the users telephone must have a message 
waiting lamp or LCD or stutter dial tone, programmed in order to determine a 
message has been left for the user. INTUITY LX will handle only the MWI 
ON/OFF code and it is the responsibility of the switch to interpret the code 
and switch MWI ON/OFF on the user’s telephone appropriately. 
 

Programming on the Merlin Magix can be done using a system 
programming console or a personal computer with System Programming 
and Maintenance software. With both methods, the screens seen while 
programming are identical. For details, refer to the AVAYA Merlin Magix 
Communications System Programming Manual.  

Configuring the Merlin 
Magix to integrate  
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 Once you are logged into the Merlin system, the System Programming 
menu will appear as follows: 

System Programming :

Make a selection

System Extensions

SysRenumber Options

Operator Tables

LinesTrunks AuxEquip

Exit NightSrvce>

System Programming Menu  

 
 The Legend system must be configured as a hybrid/PBX. This 

programming must be done when the system is idle. In addition, this 
programming will cause the system to restart when you are finished. 
Therefore, choose an appropriate time for this procedure. 

• From the System Programming menu, select System. 

• From the System menu, select Mode. 

• Within the Mode menu, select Hybrid/PBX. 

• To save your selection, press enter. 

• At this point, the system will restart as noted above. To continue 
programming, re-enter system programming. 

 If necessary, install 016 analog ports for INTUITY AUDIX LX  One 
analog port is required for each INTUITY AUDIX LX port. 

 Program the Voice Mail System/Automated Attendant Options as 
follows: 

• From the System Programming menu, select AuxEuip, to reach 
the Auxiliary Equipment menu. 

• From the Auxiliary Equipment menu, select VMS/AA. 

• From the VMS/AA screen, select TransferRtn. This parameter, 
Transfer Return, represents the number of rings before calls 
transferred by the INTUITY AUDIX LX are sent to a designated 
backup position. Set it to “0” to disable this feature. If supervised 
transfer applications are used, this parameter should either be 
disabled, or set to a greater value than the “number of rings for 
on-PBX  calls” parameter in INTUITY AUDIX LX system 

The Merlin Magix system must be 
configured as a hybrid/PBX 

Program the Voice Mail 
System/Automated Attendant 

Options 
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management. 
- The default value for Transfer Return is 4.  To modify this 
parameter, erase the current setting, using the Drop key. Enter 
the desired value and press enter.  

• From the VMS/AA screen, select TT Duration. This parameter 
should be set to 75 (milliseconds). If it is not, erase the current 
setting (using the Drop key) and enter 75. Press enter to save 
your entry. 

• From the VMS/AA screen, select TT Interval. This parameter 
should be set to 50 (milliseconds). If it is not, erase the current 
setting (using the Drop key) and enter 50. Press enter to save 
your entry. 

• Press exit twice to return to the System Programming menu. 

 Create a calling group for the INTUITY AUDIX LX ports: 

• From the System Programming menu, select Extensions. 

• Display the second page of the Extensions menu using the More 
key on the console (on a PC use the PgUp key). 

• From the Extensions menu select Group Calling. 

• From the Group Calling menu, select Hunt Type. 

• Enter an extension number to be assigned to the calling group. 
Then press enter to save your entry. This number will be the 
INTUITY AUDIX LX System Access Number. 

• The next screen asks you to select the hunt type. Choose 
Circular. 

• Press exit to return to the Group Calling menu. 

 Assign the Avaya ports as members of the calling group:  

• Magix’s Mode All 

• Factory Setting  Automatic Log Out 

• From the Group Calling Menu, select Members. 

• Next, enter the extension number just assigned to INTUITY 
AUDIX LX calling group. Press enter to save your entry. 

• At the “Enter group members” prompt, specify the first 
INTUITY AUDIX LX port with one of the following: 

-extension number nnnn (will be 3 or 4 digits) 
-slot and port number *sspp 
• -logical ID number #nnn 

 

Create a calling group for the 
INTUITY AUDIX LX ports 

Assign the INTUITY AUDIX LX 
ports as members of the calling 

group 
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• If the INTUITY AUDIX LX ports are in sequential number, 
press the Next key to add the next INTUITY AUDIX LX port. If 
the INTUITY AUDIX LX ports are not sequential, press Enter 
to add the next INTUITY AUDIX LX port. Repeat until all 
INTUITY AUDIX LX ports have been added to the calling 
group. 

• When all INTUITY AUDIX LX ports have been added, verify 
your entries by using the Inspect key on the console. (If you are 
using a PC to program the Legend, press PgDn and then the F5 
key.) This will list all members of the calling group. 

• Press exit to return to the Group Calling menu. 

 Assign the Group Type for the INTUITY AUDIX LX calling group. 
This parameter tells the Legend to send mailbox ID information on 
calls to the INTUITY AUDIX LX system. In addition, it will 
automatically log in the INTUITY AUDIX LX ports after a power 
failure. 

• At the Group Calling menu, select More to see the second page 
of the menu. 

• From the Group Calling menu, select Group Type.  

• Enter the extension number of the INTUITY AUDIX LX calling 
group. Press enter to save your entry.  

• At the next screen, select Integ VMI. Press enter to save your 
selection. 

• To return to the Extensions menu, press exit twice. 

 Program the INTUITY AUDIX LX as the call coverage target: 

• Use the More key to reach the second page of the Extensions 
menu. Then, select Group Coverage. 

• Enter a number from 1 to 30 as the coverage group number for 
the INTUITY AUDIX LX system. Press enter. 

• When prompted for extension numbers, enter only the extension 
number assigned to the INTUITY AUDIX LX calling group. 
Press enter. 

• To return to the System Programming menu, press exit twice. 

 Program the Group Coverage Delay Interval. This is the number of  
rings after which the Merlin Magix will send calls to the INTUITY 
AUDIX LX system. 

• From the System Programming menu, select Options. 

Assign the Group Type for the 
INTUITY AUDIX LX AUDIX LX 

calling group 

Program the INTUITY AUDIX LX 
AUDIX LX system as the call 

coverage target 



Merlin Magix  

 

The information contained in this document is provided by AVAYA Inc. to serve as a guide.  See the disclaimer on page 1. 

7

• Use the More key to reach the second page of the Options menu. 
At this screen, choose Group Coverage Delay Interval. 

• Erase the current entry using the Drop key. Now specify the 
number of desired rings, from 1 to 9. Press enter. 

• To return to the System Programming menu, press exit. 

 To assign trunks to be answered directly by the INTUITY AUDIX LX  
system, perform the following programming: 

• From the System Programming menu, select Extensions. 

• Use the More key to reach the second page of the menu. At this 
screen, choose Group Calling. 

• At the Group Calling menu, select Line/Pool. 

• Next, enter the INTUITY AUDIX LX calling group extension 
number. Press enter. 

• At the “Enter line/pool numbers” prompt, identify the trunk or 
trunk pool that you want the INTUITY AUDIX LX system to 
answer. This can be done in one of three ways: 

• -Line or trunk number nnn 
• -slot and port number *sspp 
• -logical ID number #nnn 

 
 
 
 
 
 

- continued on next page - 

To assign trunks to be 
answered directly by the 

INTUITY AUDIX LX AUDIX LX 
system, perform the following 

programming 
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6.0  CONFIGURING THE INTUITY AUDIX LX TM  
For more information on configuring the INTUITY AUDIX LX TM, click 
Help on the appropriate page, or refer to the INTUITY AUDIX LX TM CD 
ROM and refer to the Switch Integration chapters for detailed information. 
 

 The following are the steps required for an INTUITY AUDIX LX TM. 
R2.x. INTUITY AUDIX LX 2.x uses a simpler GUI as shown in our 
example screen below. All you need do is open the category you will 
administer (shown in yellow text next to the small white triangles in the 
left column). You can expand these by click on the white triangle to left of 
it. Once this is done the category will expand providing choices below it. 
In our example we have opened Switch Administration. The triangle points 
down to indicate it is open.  

Here we selected Interface Parameters. This is noted by the white rectangle 
around the text Interface Parameters in blue.   

 

 

 

 

 

 

 

 

 

 

 

 

 

HINT:  When changes to the Switch Interface Administration are 
completed, the voice system must then be stopped and started.  

• Start at the Administration main menu          
• Select Basic System Administration. 
• Select Switch Selection.  
Once a selection is made the appropriate screen will open allowing you 
to enter the parameters as noted in the CN.   

Important:  This is an example screen of IALX R2.x Administration. The 
values shown here are not necessarily the ones you need to 
enter. Please read the CN for more detailed information.  
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NOTE: The Merlin/Magix Mode Code software may have to be loaded 
from the software CD that came with the Intuity LX. 

• Under Switch Administration:  
- Click on Switch Selection  
- Select UNITED STATES – MERLIN MAGIX/LEGEND 

- Click Save    
NOTE: You must stop and start the voice system to make these changes active. 

• Under Voice System Admin 
- Click on Assign Chans to Groups 
- If you are setting up different channels to different groups, 

complete these fields as follows: 
o Channels: Enter a number or range (for example, 0,1,2 or 0 1 

2 or 2-4 or all). 
o Groups: Enter a number or range (for example, 0,1,2 or 0 1 2 

or 2-4 or all).  
- Click Save     

NOTE:   By default, all channels are assigned to group 2.  If this 
integration requires a dedicated MWI port then the dedicated 
MWI channel must be assigned to a different group to ensure 
that the dedicated MWI channel is available to turn MWI 
on/off. You can accomplish this by reassigning (you need to 
un-assign it before reassigning it) the MWI channel from 
group 2 to group 3.  This group must be the same as that 
shown as Device ID in the Device Assignment section 
within Switch Administration.  

 If more than one dedicated MWI channel, each channel must 
be in a different group. So if you have 2 MWI channels one 
would be assigned to group 3 and the second to group 4. By 
convention, the highest numbered channels are used as 
dedicated MWI channels. 

 MWI codes may vary and should be checked to ensure that 
those being used are the same as used in the switch.  These 
are then set using the MWI parameters menu in the 
INTUITYAUDIX LXTM. 

- Click on Assign PBX Ext/Chans 
o Starting PBX Extension: Enter a phone number (the pilot 

number) for the first channel (up to 7 digits).  
o Starting Channel Number: Enter a number (start at channel 0). 
o Ending Channel Number: Enter the last channel number.  

IMPORTANT: If numbers are not sequential then you have to do this 
for each extension and channel. 

- Click Save  
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- Click on Assign Services/Chans 
o Channel: Enter the channel number and/or a range of 

numbers.  
o Service: (You have the option to select *DNIS_SVC, 

AUDIX, Chan Tran, chandip, or init_xfer). Choose 
*DNIS_SVC. 

- Click Save 

• Under Voice Equipment Diagnostics 
- Click on Display and verify that the information you entered was 

entered correctly and that the voice card is INSERV state.  

• Under Voice System Admin 
- Click on Assign Number Services  

o Called Numbers: any (the field after the “to” is blank). 
o Calling Numbers: any (the field after the “to” is blank). 
o Service Name: AUDIX. 

- Click Save 
- Click on Display Number Services and verify that the information 

was correctly entered. 

• Under Call Transfer Administration. Customers have the option to 
select numbers to be allowed or denied when they are performing 
transfers. You can add, delete and display numbers here. Restrictions 
(denied numbers) can also be administered if any are to be used. 
- If you click on Allowed Number Display, you will see the 

following for a four-digit dial plan: 
From To 
0 9999 

• Under Switch Administration.  
- Click on Device Assignment  
- You have the option to add/update these fields. 

o Switch Number: 1 
o Device ID:  The default is group 2 which can remain if a dedicated 

message waiting port is not required. 

Note: This is the group that you assign if this integration requires a 
dedicated message waiting port.  In the example in Section 6.0 on 
page 9, we suggested it be assigned to group 3.  Therefore in our 
example this parameter should be set to group 3 to indicate the 
group where you had assigned the MWI channel).  

 
o Click  Save 
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- Click on MWI Parameters  
o Verify that the MWI ON Prefix is set to: *8 (The default code is 

#90. *8 shown above is only an example. You should consult 
your PBX administrator to ensure this code matches the 
MWI ON code in the PBX.)  

o Verify that the MWI OFF Prefix is set to:  #8 (The default code 
is #91. #8 shown above is only an example. You should 
consult your PBX administrator to ensure this code matches 
the MWI OFF code in the PBX.)  

o Set MWI Update: y 
o Log MWI Update: y 
o Background Refresh: y 
o Click Save 

- Click Dial Plan Translation 
o Add or Update INTUITY Extension Length 
o Define the Switch Network Access Code: <If required> 
o Add or update the “Switch Prefix”. 
o Enter the valid extension ranges in Switch Start Ext. as 0000 and in 

Switch End Ext. as 9999. 
o Leave the INTUITY Prefix field blank. 
o Enter Switch number. This is the same number that is used in the 

AUDIX subscriber database. 
o Enter N in the Remote [Y/N] field.  
o Click Update 

- Click Trunk Translation 
o Enter the Trunk Number <if required> 

Note: This is the number passed on as call information by the 
switch for a DID call. 

o Enter INTUITY Subscriber Number. 
o Click Update.  

- Click on Transfer Parameters    
o Enter the transfer and reconnect codes for this switch. This 

information is typically gathered from the PBX vendor. 
o Basic Transfer Actions (Blind)  

Allow Transfer:  Y/N 
To initiate transfer:  fp 
To complete transfer: h 
No tones time out: 7 

 
o Intelligent Transfer Actions 

Allow Transfer: N 

The MWI ON and OFF prefixes 
for the Intuity shown here must 
match the LWC Feature Access 
Codes found in the PBX Feature 

Access Codes. 

You can verify in the PBX by 
using the PBX Administration 

command: 

display feature-access-codes 
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To initiate transfer:  
To complete transfer:  
No tones time out:  

 
o To Reconnect to Caller  

No Answer:  
Busy:  

 
o Translations for Transfer  

Intuity Prefix Required: N 
Switch Prefix Required: Y 

 
o Click Update 

 
• IMPORTANT: Once all changes are completed, the voice system 

must then be stopped and restarted. 

• HINT:  When changes to the Interface Parameters and Tones 
Parameters are completed, the voice system must then be restarted.  

 

  

7.0  HARDWARE INSTALLATION 
 Each voice card supports four analog (Tip/Ring) connections.  The 

voice path between the Merlin Magix and the INTUITY AUDIX 
LXTM requires one pair in each RJ11 connection of the voice card.  
See to the installation instructions for the hardware connectivity. 

• To ensure that the ports are physically connected correctly, ask the 
switch administrator to place calls to each individual INTUITY 
AUDIX LXTM voice channel, one at a time.  Use the System Monitor 
menu in the INTUITY AUDIX LXTM to monitor that the correct 
channel is dialed from the switch. 

7.1  TESTING THE INSTALLATION 
 Create two mailboxes associated with two test extensions. Record a 

 name and personal greeting for each mailbox.   

 By using one test extension, call the other test extension. You need to 
hear the appropriate greeting (see “Test call coverage scenarios” 
below). 

  Test call coverage scenarios:      

  Forward all calls:  When a subscriber forward all calls to the 
INTUITY AUDIX LXTM number, calls placed to the subscriber 

Connecting analog voice 
channels 
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should follow the  correct INTUITY AUDIX LXTM prompt should be 
played for that subscriber. 

 Busy: Place a call to a busy extension.  This call has to follow the 
right coverage path and INTUITY AUDIX LXTM must play the Busy 
greeting. 

 Ring-no-answer: Place a call to a station that is ring-no-answer. 
This call has to follow the right coverage path and INTUITY AUDIX 
LXTM must play ring-no-answer greeting. 

 If calls are Non-Integrated, check 

  That the appropriate COS has been assigned to the Tip/Ring lines. 

  That the PBX Extn to Channel mapping has been administered 
properly. 

  The Switch Integration log to make sure the RAW data is seen for 
every call and is appropriately parsed and translated. 

  The maintenance log to verify that an error has been logged 
indicating Bad data.  If yes, then check the switch setup to ensure 
that the correct mode codes are being passed to INTUITY AUDIX 
LXTM . 

  The Dial Plan Translation screen to verify that the translation table 
has been administered correctly. 

 For message-waiting indicators, listen to the message left for the test 
mailbox, delete the message, and verify that message waiting is turned 
off. 

 If Message Waiting failures occur, check the following: 

  That the appropriate COS has been administered on the switch or 
the subscriber telephone sets. 

  The Switch Integration Log to verify that INTUITY AUDIX LXTM 
is dialing out the required sequence of digits.  If not, check the 
DIAL PLAN Translation and make sure that it is administered 
correctly. 

  That dial tone is being detected by INTUITY AUDIX LX TM.   

  That the MWI sequence that is dialed out by INTUITY AUDIX 
LX TM is the same as set on the switch.  Ask the switch 
administrator for the MWI sequence. If it is different, then change 
the MWI ON Prefix and Suffix to reflect the correct value. 

If MWI updates take a long time, then dedicate another channel for MWI 
(that is, no incoming calls on these lines).  Assign a unique Channel Group 
to the particular channels and administer the Device Assignment screen to 
this value (the value is 2, as all channels are assigned Group 2). 
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 Test Transfers by using the *T option from the Audix mailbox, 
transfer to another mailbox.  Monitor the transfer time. Transfer to a 
station that is in a Do-Not-Disturb mode, busy mode, RNA mode. 

  The transfer time is approximately from 5 to 8 seconds. 

 Test multiple transfers. Set up phone A to transfer to Phone B. 
Phone B then transfers to phone C, and phone C transfers to phone 
D. Determine how many transfers can be supported on the switch. 

 If Transfer failures are encountered, then check the following: 

 That the flash duration that is set on INTUITY AUDIX LXTM is the 
same as that configured on the switch. If not, then modify the flash 
duration. 

 That the transfer type is set on the change system-parameters 
feature form. 

NOTE:  If the caller is disconnected during transfers, then the flash 
duration is too high and has to be reduced.  If the caller hears 
INTUITY AUDIX LX dialing digits during transfer, then the flash 
duration is too low and has to be increased. 

 Call Disconnect. Leave a message for the test mailbox, retrieve the 
message, and listen for the call progress tones. Place an external call 
and document the time that it takes the INTUITY AUDIX LXTM to 
disconnect after the caller hangs up.    

   If there is no progress tone in the message, disconnect is working 
fine. 

 Zero (“0”) Out. Verify that return-to-operator works properly. 

 Call the INTUITY AUDIX LXTM from a test extension and leave a 
message for a station with a voice mail button. 

 If the subscriber stations are programmed to support a button that 
will dial the voice mail access number and the mailbox number 
followed by the # sign, the INTUITY AUDIX LXTM will prompt for 
the password. The system will play “Please enter your password”. 

 Automated Attendant. Call the automated attendant mailboxes. 

 If the correct Auto-Attendant mailbox is not reached and all the 
previously described tests passed, the most likely problem will be in 
the switch translations.  Check with the system administrator to 
Ensure proper translation. 

 Set up outcall notification in the test mailbox and leave a message to 
generate an outcall.  Make sure that the ports are configured for 
Outcall. 
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 INTUITY AUDIX LXTM must call the number administered for 
outcalling after the administered time has passed. 

 If Outcalling failures occur, check to see if the INTUITY AUDIX 
LX is detecting the dial tone.   

  Incoming and Outgoing Fax 

 Send a fax to a subscriber mailbox from a fax machine.  Click the 
Start key on the fax machine.  Check that the fax arrived in the 
mailbox and print the fax. 

 Send a fax from a subscriber’s mailbox to a fax machine.  Check the 
fax machine to make sure that the fax was received.  

NOTE:  If you encounter problems while performing these tasks, review 
the “switch log” before escalating problems to your local Technical 
Support Center. 

8.0  CONSIDERATIONS 
8.1 The Legend does not provide consistent disconnect signaling. 

As a result, it might be necessary for the INTUITY AUDIX LX to 
rely upon silence detection to disconnect when callers hang up. 
Silence detection might take up to 30 seconds to disconnect. Caller 
prompting and subscriber training are recommended to encourage 
callers and subscribers to exit the INTUITY AUDIX LX 
completely when finished. 

8.2 The Legend must be programmed as a hybrid/PBX for 
integration. Integration is not currently supported for Merlin 
Magix systems configured as key systems. 

8.3 With release 1 software, stations on the Legend cannot all-calls 
forward to the pilot number of a calling group (hunt group). 
The do-not-disturb feature on the Merlin Magix is suggested as an 
alternative. This feature when activated at a station will suppress 
the ringing of incoming external calls. External calls will then 
follow any call coverage programmed for that station. Internal 
callers will receive busy tone when dialing a station in do-not-
disturb and will not follow call coverage programming. Release 2 
software will allow all-calls forwarding to the voice-processing 
module. 

8.4 The minimum mailbox length is 3-digits. Therefore, the Merlin 
Magix must be configured with 3- or 4-digit extensions for 
integration. (The range of extension lengths on the Legend is 
1 to 4.) 

8.5 Analog 016TRR cards that are application 18 or older may 
experience intermittent loss of dial-tone and/or the inability to 

Important notes regarding this 
integration 
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recognize loop current.  Analog 016TRR application 19 or higher 
cards eliminate this problem.   

8.6 When using analog 016 TRR cards the IA LX will not reboot 
unless dial tone is removed to IA LX Dialogic board. For this 
reason we require a minimum release of 016TRR cards. Please 
refer to Section 3.0. 
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